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BAB III  

METODE PENELITIAN 

A. Jenis dan Pendekatan Penelitian  

Jenis penelitian ini adalah eksperimen lapangan, yakni penelitian yang di-

tujukan untuk mengetahui pengaruh dari suatu perilaku tertentu dengan kondisi ter-

tentu secara sengaja. Pendekatan penelitian ini menggunakan pendekatan kuanti-

tatif, yaitu metode yang didasarkan pada filsafat positivisme untuk meneliti popu-

lasi atau sampel tertentu dengan meggunakan teknik pengumpulan data, 

menggunakan instrumen penelitian dan analisis data dengan statistik (Wahyuni, 

2019). 

B. Desain Penelitian 

Desain penelitian yang digunakan dalam penelitian ini adalah non equiva-

lent control group desain menggunakan post-test only. Alasan penggunaan desain 

ini, karena setelah dilakukan uji kesamaan dua rata-rata pada kelompok eskperimen 

dan kontrol diperoleh bahwa tidak terdapat perbedaan rata-rata hasil ulangan materi 

sebelumnya pada kedua kelompok. Dalam desain ini kelompok eskperimen dan ke-

lompok kontrol akan dibandingkan melalui tes akhir berupa post-test.  Kedua kelas 

pada penelitian ini mendapatkan materi pembelajaran yang sama yaitu koloid na-

mun menggunakan perlakuan yang berbeda. Pada kelas eksperimen diberi perla-

kuan dengan menggunakan model pembelajaran PjBL yang berbasis etnokimia se-

dangkan pada kelas kontrol menggunakan model konvensional dengan pendekatan 

scientific yang sudah biasa digunakan. Pada akhir penelitian di kedua
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kelas tersebut akan diberikan soal post-test. Desain penelitian dapat dilihat pada 

Tabel 3.1 (Sugiyono, 2018). 

Tabel 3.1 Desain Penelitian 

Kelompok Perlakuan Pascates 

Eksperimen X O1 

Kontrol - O2 

 

Keterangan : O1 = post-test kelompok eksperimen  

          O2 = post-test kelompok kontrol 

          X = Perlakuan 

Dalam penelitian ini yang menjadi variabel bebas adalah model pembelaja-

ran PjBL berbasis etnokimia, variabel terikat adalah hasil belajar dan yang menjadi 

variabel kontrol adalah guru, materi yang diajarkan dan jumlah waktu perlakuan. 

Pengaruh variabel bebas terhadap variabel terikat dapat dilihat dari perbedaan skor 

post-test dari kelompok eksperimen (O1) dan kelompok kontrol (O2). Apabila skor 

kelompok eksperimen (O1) lebih tinggi dibandingkan dengan skor pada kelompok 

kontrol (O2) maka dapat disimpulkan bahwa perlakuan yang diberikan memiliki 

pengaruh terhadap perubahan yang terjadi pada variabel terikat.  

C. Setting Penelitian 

1.  Lokasi Penelitian 

Lokasi penelitian yang dipilih adalah MAN 3 Banjar. MAN 3 Banjar  ter-

letak di Jl. A.Yani Km. 15 di Kecamatan Gambut, Kabupaten Banjar, Provinsi Ka-

limantan Selatan. Letak geografisnya apabila dilihat dari aplikasi pemindai lokasi 

(google maps) terdapat pada Gambar 3.1. 
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   Gambar 3.1 Lokasi MAN 3 Banjar pada Google Maps 

2. Waktu  Penelitian 

Penelitian ini dilaksanakan pada tanggal 02 Mei 2023 sampai dengan tang-

gal 26 Mei 2023.   

3. Jadwal Penelitian 

Penelitian dilakukan di dua kelas yakni pada kelas XI MIPA 1 dan kelas XI 

MIPA 2 yang terbagi menjadi 3 pertemuan di tiap kelasnya. Jadwal penelitian yang 

dilakukan peneliti dapat dilihat pada Tabel 3.2.  

Tabel 3.2 Jadwal Penelitian 

No Tanggal Kegiatan Keterangan 

1 Selasa, 02 Mei 2023 Pembuatan surat riset dari kam-

pus UIN Antasari Banjarmasin 

Lampiran 
2 Jum’at,َ05َMeiَ2023 Pembuatan surat izin riset dari 

MAN 3 Banjar 

3 Jum’at,َ05َMeiَ2023 Persetujuan izin riset dari ke-

mentrian agama  

4 Senin, 09 Mei 2023 Pertemuan ke-1 

Materi :  

- Perbedaan larutan, suspensi 

dan koloid 

- jenis sistem koloid berdsar-

kan fase terdispersi dan 

pendispersi  

Jam pelajaran 2-3 

kelompok kontrol 

5 Selasa, 10 Mei 2023 
Jam pelajaran 3-4 

kelompok eksper-

imen 

6 Rabu, 11 Mei 2023 Pertemuan ke-2 

Materi : sifat-sifat koloid  

Jam pelajaran 1-2 

kelompok kontrol 



29 

 

 

 

No Tanggal Kegiatan Keterangan 

Jam pelajaran 3-4 

Kelompok ek-

sperimen 

7 Senin, 22 Mei 2023  Pertemuan ke-3 

Materi :  

- Proses pembuatan koloid  

- Penerapan koloid dalam ke-

hidupan sehari-hari 

Jam pelajaran 2-3 

Kelas kontrol 

8 Selasa, 23 Mei 2023 
Jam pelajaran 3-4 

Kelas eksperimen 

9 Rabu, 24 Mei 2023 Melaksanakan posstest Jam pelajaran 1-2 

Kelas kontrol 

Jam pelajaran 3-4 

Kelas eksperimen 

10 Jum’at,َ26َMeiَ2023 Pembuatan surat selesai riset  
Lampiran 

 

D. Populasi dan Sampel Penelitian 

1. Populasi Penelitian 

Populasi dalam penelitian ini adalah seluruh kelas XI MIPA MAN 3 Banjar 

pada tahun ajaran 2022/2023. Jumlah kelas XI MIPA di sekolah ini ada 2 kelas, 

yaitu XI MIPA 1 yang berjumlah 16 peserta didik dan XI MIPA 2 yang berjumlah 

14 orang peserta didik. 

2. Sampel Penelitian 

Penggunaan sampel dalam sebuah penelitian merupakan bagian yang pent-

ing dalam proses pengumpulan data. Sampel adalah bagian dari jumlah dan karak-

teristik yang dimiliki oleh populasi. Pengambilan sampel pada penelitian ini 

menggunakan teknik sampling total. Teknik sampling total di mana seluruh anggota 

populasi dijadikan sampel (Sugiyono, 2018).  
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Berdasarkan hal tersebut, diperoleh  yang menjadi sampel penelitian untuk 

kelas eksperimen adalah kelas XI MIPA 1 yang berjumlah 16 orang peserta didik 

dan yang menjadi kelas konrol adalah kelas XI MIPA 2 yang berjumlah 14 orang 

peserta didik. 

E. Data dan Sumber Data 

1. Data  

a. Data Primer  

Data yang didapat langsung dari sumber pertama disebut data primer. Da-

lam penelitian ini yang menjadi data primer adalah adalah hasil belajar kognitif 

peserta didik pada materi koloid. Pengumpulan data primer diharapkan menjadi in-

formasi yang relevan terkait hasil belajar peserta didik pada materi yang diajarkan.  

b. Data Sekunder  

Data yang diperoleh dari sumber kedua disebut data sekunder. Selain dari 

yang diteliti, data ini bertujuan untuk mendukung penelitian yang dilakukan 

(Sugiyono, 2013). Data sekunder diperoleh dari penilaian afektif dan psikomotorik 

siswa serta observasi langsung terhadap proses pembelajaran dan dokumen-doku-

men terkait dengan sekolah MAN 3 Banjar, yaitu: 

1) Penilaian afektif dan psikomorik siswa 

2) Hasil observasi keterlaksanaan model pembelajaran 

3) Jadwal pembelajaran peserta didik kelas XI MIPA di MAN 3 Banjar 

2. Sumber Data  

Pada penelitian ini yang menjadi sumber data terdapat pada Tabel 3.3. 

.  
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Tabel 3.3 Sumber Data 

No Sumber data Keterangan 

1. 
Responden Siswa kelas XI MIPA MAN 3 

Banjar 

2. 
Informan Guru kimia dan staf Tata Usaha 

di MAN 3 Banjar 

3. 
Dokumen Catatan-catatan atau foto-foto 

terkait dengan penelitian 

4. Observer Teman sejawat 

F. Teknik Pengumpulan Data 

Teknik pengumpulan data merupakan cara yang ditempuh peneliti dalam 

mengumpulkan data penelitian. Teknik yang digunakan dalam pengumpulan data 

dalam penelitian ini adalah sebagai berikut:  

1. Tes  

Tes yang digunakan dalam penelitian ini adalah tes kognitif yang berupa 

soal post-test berbentuk pilihan ganda dengan jumlah 19 soal. Terdapat beberapa 

indikator pembelajaran dan nomor soal yang digunakan dalam penelitian ini, yang 

dipaparkan pada Tabel 3.4. 

Tabel 3.4 Indikator Pembelajaran dan Nomor Soal 

Indikator Pembelajaran Nomor Soal 

3.14.1 Menganalisis perbedaan larutan, suspensi dan ko-

loid. 
1,2, 3 dan 4 

3.14.2 Menentukan jenis sistem koloid berdasarkan fase 

terdispersi dan medium pendispersinya. 5,6,7 dan 8 

3.14.3 Menyimpulkan sifat-sifat koloid  9, 10, 11, 12, 13 

3.14.4 Menjelaskan proses pembuatan koloid 14 dan 15 

3.14.5 Menganalisis penerapan koloid   dalam ke-

hidupan sehari-hari 
16 

4.15.1 Merancang dan melakukan      percobaan tentang 

pembuatan produk koloid 
17, 18 dan 19 
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Tes ini digunakan untuk mengetahui hasil belajar peserta didik dalam ranah 

kognitif terhadap materi koloid yang telah dipelajari. Tes ini diberikan kepada kelas 

eskperimen dan kelas kontrol sesudah kegiatan pembelajaran selesai dilakukan. 

Melalui tes ini, diharapkan dapat memgukur hasil belajar peserta didik pada materi 

koloid. Sebelum tes diberikan pada kedua kelas, tes tersebut diuji cobakan terlebih 

dahulu kepada peserta didik diluar sampel yang telah mempelajari materi yang 

diteliti. Tes di uji cobakan pada kelas XII MIPA di MAN 3 Banjar. Setelah uji coba 

instrumen tes, langkah selanjutnya adalah menganalisis validitas dan reliabilitas 

dari hasil uji coba tersebut. Analisis tes dilakukan dengan menggunakan software 

SPSS versi 24.  

2. Observasi 

Observasi pada penelitian ini menggunakan lembar observasi keterlaksaan 

model pembelajaran dan penilaian afektif (sikap) dan psikomotorik (keterampilan). 

Observasi keterlaksanaan model pembelajaran dilakukan oleh observer. Di mana 

observer mengamati dan mengawasi keterlaksanaan model pembelajaran yang dil-

akukan oleh peneliti kepada masing-masing sampel. Tujuannya untuk memastikan 

setiap langkah dalam proses pembelajaran yang dilakukan sudah sesuai dengan uru-

tan yang sudah ditentukan. Sedangkan penilaian afektif dan psikomotorik, dil-

akukan saat proses pembelajaran berlangsung dengan menggunakan rubrik 

penilaian afektif dan psikomotorik yang terlampir pada lampiran 18. 
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3. Dokumentasi  

Dokumentasi dilakukan untuk mendapatkan data berupa catatan-catatan dan 

dokumen lainnya yang berkaitan dengan penelitian. Dalam penelitian ini, peneliti 

mengumpulkan berbagai dokumen yang berkaitan dengan penelitian seperti foto-

foto yang diambil saat proses pembelajaran berlangsung, jadwal pembelajaran serta 

materi pembelajaran yang digunakan.  

G. Instrumen Penelitian 

Instrumen adalah alat yang digunakan peneliti dalam mengumpulkan data 

pada saat proses penelitian. Instrumen yang digunakan peneliti dalam penelitian ini 

meliputi instrumen pengukuran dan instrumen perlakuan yang diterapkan pada ke-

las eksperimen dan kelas kontrol dengan model pembelajaran yang sudah ditetap-

kan. Instrumen penelitian yang digunakan peneliti dapat dilihat pada Tabel 3.5. 

Tabel 3.5 Instrumen Penelitian 

No Jenis Instrumen Instrumen 

1. Instrumen Pengukuran Soal post-test berbentuk pilihan ganda yang 

berjumlah 25 soal  

 

2. Instrumen Perlakuan Silabus, Rencana Pelaksanaan Pembelajaran 

(RPP), Lembar Kerja Peserta Didik (LKPD), 

dan lembar observasi kerterlaksanaan model 

pembelajaran 

 

Instrumen tersebut selanjutnya akan di valiasi oleh ahli yang terdiri dari 2 

orang dosen kimia dan 1 orang guru kimia. Adapun kriteria hasil validasi dapat 

dilihat dalam Tabel 3.6 (Sa’adunَAkbar,َ2013). 

 

 



34 

 

 

 

 

Tabel 3.6 Kriteria Hasil Validasi 

No Skor Kriteria Validitas 

1. 81 - 100 % Sangat Layak 

2. 61 - 80 % Layak 

3. 41 - 60 % Cukup Layak 

4. 21 - 40 % Tidak Layak 

5. < 21 % Sangat Tidak Layak 

 

Validitas instrumen ini telah dikonfirmasi dan divalidasi dengan beberapa 

dosen ahli serta satu guru kimia berpengalaman dari MAN 3 Banjar. Hasil validasi 

instrumen dapat dilihat pada Tabel 3.7. 

Tabel 3.7 Hasil Validasi Instrumen  

No Instrumen 

Alvian Ikh-

sanul 

Fatya, 

S.Pd., M.Si 

Khairiatul 

Muna, 

M.Pd 

Naimah, 

S.Pd 
Rata-Rata 

1. Soal Tes 91,79% 80% 75,83% 82,54% 

2. Silabus 97,5% 100% 82,50% 93,33% 

3. 
RPP Kelas Ek-

sperimen 
85% 78,33% 75% 79,44% 

4. 
RPP Kelas 

Kontrol 
78,57% 80% 77,14% 78,57% 

5. 
LKPD Kelas Ek-

sperimen 
77,14% 80% 80% 79,04% 

6. 
LKPD Kelas 

Kontrol 
88,33% 78,33% 76,66% 81,10% 

7. 

Lembar Observasi 

Keterlaksanaan 

Pembelajaran 

96,66% 80% 76,66% 84,44% 

 

Setelah dilakukan validasi didapat hasil bahwa instrumen ini memiliki ting-

kat validitas yang layak dan diharapkan dapat mengukur hasil belajar peserta didik. 

Dengan penggunaan instrumen tersebut, diharapkan diperoleh data-data yang valid 

dan relavan untuk analisis penelitian ini. Langkah selanjutnya setelah tahap validasi 

adalah dilakukan uji coba soal, untuk mengevaluasi kecocokan dan keberterimaan 
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soal yang telah disusun. Uji coba soal ini dilakukan terhadap 28 orang peserta didik 

kelas XII MIPA yang telah mempelajari materi koloid. Hasil uji coba tersebut, men-

jadi dasar dalam melanjutkan pengujian validitas dan reabilitas. Apabila instrumen 

tersebut valid dan reliabel maka instrumen dapat dipergunakan dalam penelitian.  

H. Teknik Analisis Data 

Teknik analisis data bertujuan untuk mengolah serta menganalisis data hasil 

belajar. Adapun teknik analisis data yang digunakan antara lain sebagai berikut.  

1. Statistika Deskriptif 

Statistika yang digunakan untuk menganalisis data dengan mendeskripsikan 

data yang diperoleh dengan apa adanya, tanpa bermaksud membuat kesimpulan 

yang berlaku umum dan generalisasi disebut statistiak deskriptif (Sugiyono, 2018). 

Statistika deskriptif digunakan untuk menyajikan data yang diperoleh melalui hasil 

tes akhir peserta didik (post-test). Kriteria hasil belajar dapat dilihat pada Tabel 3.8 

(Masyhud, 2013).  

Tabel 3.8 Kriteria Penilaian Hasil Belajar 

Kriteria Hasil Belajar Rentangan Skor 

Sangat Baik 80-100 

Baik 70-79 

Sedang/Cukup 60-69 

Kurang 40-59 

Sangat Kurang 0-39 

 

Dengan menggunakan kriteria hasil belajar, dapat diketahui kriteria data 

yang sudah diperoleh. Dalam statistika deskriptif digunakan analisis data seperti 

mean, standar deviasi, skor maksimum dan skor minimum agar lebih mudah untuk 

dipahami.  
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a. Mean (rata-rata) 

Untuk menentukan kualifikasi hasil belajar oleh peserta didik dapat 

diketahui rata-rata dengan rumus sebagai berikut. 

𝑋 =
∑𝑓𝑖𝑥𝑖

∑𝑓𝑖
 

Keterangan: 

𝑋     = Nilai rata-rata (mean) 

∑fixi= Jumlah hasil perkalian data dengan frekuensinya 

∑fi  = Jumlah data  

b. Standar Deviasi 

Standar deviasi atau simpangan baku digunakan untuk menghitung Zi pada 

uji normalitas. Menurut Sugiyono (2016) untuk menghitung standar deviasi 

digunakan rumus sebagai berikut. 

s =√∑(𝑥𝑖−𝑥) 

𝑛−1 
 

Keterangan : 

s = Standar Deviasi Sampel 

𝑥 = Nilai rata-rata (mean) 

n = Banyaknya data  

xi = Data ke-i,َyangَmanaَiَ=َ1,2,3,… 

 

 

 

2 
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2. Uji Prasyarat 

a) Analisis Data Sebelum Penelitian 

1) Uji Normalitas 

Uji normalitas digunakan untuk mengetahui kenormalan distribusi data 

pada sebuah kelompok data atau variabel, apakah sebaran data terdistribusi normal 

atau tidak. Data yang normal adalah syarat utama sebelum melakukan analisis 

statistik parametrik. Uji normalitas dalam penelitian ini dilakukan menggunakan 

software SPSS versi 24 yang diuji dengan Kolmogorov-Smirnov. Berikut langkah-

langkah uji normalitas dengan Kolmogorov-Smirnov pada SPSS, yaitu:  

Data View→َAnalyze →  Descriptive Statistics → Explore → Dependent 

List→ Both Pada Bagian Display→Plots →َFactor Level Together→ Normality 

Plots with Test → Continue →َOkَ 

Pembacaan data: P > 0,05 = data terdistribusi normal.  

P < 0,05 = data tidak terdistribusi normal.  

Berdasarkan hasil uji normalitas diperoleh bahwa nilai Sig. 0,200 > 0,05, dapat 

disimpulkan bahwa data yang diuji terdistribusi normal.  

2) Uji Homogenitas   

Uji homogenitas digunakan untuk mengetahui kelompok data berasal dari 

populasi yang mempunyai variasi yang homogen atau tidak. Uji homogenitas ini 

dilakukan dengan menggunakan software SPSS versi 24. Berikut langkah-langkah 

uji homogenitas pada SPSS, yaitu:  
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Data View →َAnalyze → Descriptive Statistics → Explore → Plots → none 

pada boxplots→ steam and leaft di select pada descriptive → power estimation 

→Continue →َOk 

Pembacaan data: P > 0,05 = data terdistribusi homogen.  

P < 0,05 = data tidak terdistribusi tidak homogen. 

Berdasarkan hasil uji homogenitas diperoleh bahwa nilai Sig. 0,602 > 0,05, 

dapat disimpulkan bahwa data yang diuji terdistribusi homogen. 

3) Uji Kesamaan Dua Rata-rata 

Uji kesamaan dua rata-rata dilakukan untuk mengetahui kemampuan awal 

peserta didik yang dijadikan sampel tidak berbeda, untuk mencari kesamaan dua 

rata-rata menggunakan rumus uji T dua pihak, karena data awal berdistribusi nor-

mal dan varian homogen.  

Penelitian ini menggunakan software SPSS versi 24 dengan uji Independent 

Sample T-Test. Berikut langkah-langkah uji homogenitas pada SPSS, yaitu:  

Analyze → Compare Means → Independent Sample T-Test → Test Variable 

→ Grouping Variables → Ok 

Dalam proses pengambilan keputusan berdasarkan kriteria signifikasi 

digunakan nilai 𝛼 = 0,05.  

 Jika thitung > tTabel, pada taraf signifikasi 5% dan nilai probabilitas (sig) < 0,05 

maka H0 ditolak dan H1 diterima. 

 Jika thitung < tTabel, pada taraf signifikasi 5% dan nilai probabilitas (sig) > 0,05 

maka maka H0 diterima dan H1 ditolak. 

H0 = Tidak terdapat perbedaan rata-rata pada kelas eksperimen dan kelas kontrol. 
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H1 = Terdapat perbedaan rata-rata pada kelas eksperimen dan kelas kontrol. 

Berdasarkan hasil uji Independent Sample T-Test diperoleh nilai Sig. 0,057 

> 0,05, dapat disimpulkan bahwa tidak terdapat perbedaan rata-rata di kelas ekper-

imen dan kelas kontrol. 

b) Analisis Data Sesudah Penelitian 

1) Uji Normalitas 

Uji normalitas digunakan untuk mengetahui kenormalan distribusi data 

pada sebuah kelompok data atau variabel, apakah sebaran data terdistribusi normal 

atau tidak. Data yang normal adalah syarat utama sebelum melakukan analisis 

statistik parametrik (Paired Samplel T-Test dan Independent Sample T-Test). Uji 

normalitas dalam penelitian ini dilakukan menggunakan software SPSS versi 24 

yang diuji dengan Kolmogorov-Smirnov. Berikut langkah-langkah uji normalitas 

dengan Kolmogorov-Smirnov pada SPSS, yaitu:  

Data View→َAnalyze →  Descriptive Statistics → Explore → Dependent 

List→ Both →Plots →َFactor Level Together→ Normality Plots with Test → Con-

tinue →َOkَ 

Pembacaan data: P > 0,05 = data terdistribusi normal 

P < 0,05 = data tidak terdistribusi normal 

Berdasarkan hasil uji normalitas diperoleh bahwa nilai Sig. 0,194 > 0,05, 

dapat disimpulkan bahwa data yang diuji terdistribusi normal. 

2) Uji Homogenitas   

Uji homogenitas digunakan untuk mengetahui kelompok data berasal dari 

populasi yang mempunyai variasi yang homogen atau tidak. Uji homogenitas ini 
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dilakukan dengan menggunakan software SPSS versi 24. Berikut langkah-langkah 

uji homogenitas pada SPSS, yaitu:  

Data View →َAnalyze → Descriptive Statistics → Explore  → Plots → none 

in boxplots→ steam and leaft di select pada descriptive → power estimation → 

Continue →َOk 

Pembacaan data: P > 0,05 = data terdistribusi homogen 

P < 0,05 = data tidak terdistribusi tidak homogen 

Berdasarkan hasil uji homogenitas diperoleh bahwa nilai Sig. 0,403 > 0,05, 

dapat disimpulkan bahwa data yang diuji terdistribusi homogen. 

3) Uji Hipotesis  

Uji hipotesis dilakukan untuk mengetahui ada tidaknya pengaruh hasil bela-

jar peserta didik pada materi koloid di antara kelas eksperimen dan kelas kontrol 

dengan menggunakan data post-test. Pada data post-test digunakan untuk menge-

tahui apakah terdapat pengaruh dari model pembelajaran PjBL berbasis etnokimia 

terhadap hasil belajar peserta didik. Penelitian ini menggunakan software SPSS 

versi 24 dengan Independent Sample T-Test. Berikut langkah-langkah uji homogen-

itas pada SPSS, yaitu:  

Analyze → Compare Means → Independent Sample T-Test → Test Variable 

→ Grouping Variables → Ok 

Dalam proses pengambilan keputusan berdasarkan kriteria signifikasi 

digunakan nilai 𝛼. Adapun ketentuan taraf signifikasi 𝛼 = 0,05 yaitu sebagai berikut  

Jika thitung > tTabel, pada taraf signifikasi 5% dan nilai probabilitas (sig) < 0,05 maka 

H0 ditolak dan Ha diterima 
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Jika thitung < tTabel, pada taraf signifikasi 5% dan nilai probabilitas (sig) > 0,05 maka 

maka H0 diterima dan Ha ditolak 

Berdasarkan hasil uji Independent Sample T-Test diperoleh nilai Sig. 0,0403 

< 0,05, dapat disimpulkan bahwa model pembelajaran PjBL berbasis etnokimia 

memberikan pengaruh terhadap hasil belajar peserta didik pada materi koloid di 

MAN 3 Banjar.  

I. Teknik Validitas dan Keabsahan Data  

Teknik ini dilakukan dengan menguji instrumen penelitian apakah suatu 

data yang diperoleh valid dan reliabel dengan menggunakan uji validitas dan reli-

abilitas dengan bantuan sofware SPSS versi 24. 

1) Uji Validitas  

a) Validasi Isi 

Validitas merupakan suatu pengukuran untuk menunjukkan tingkat kevali-

dan dan ketepatan suatu instrumen (Budiastuti & Bandur, 2018). Sebelum 

digunakan untuk instrumen soal yang akan digunakan akan diuji validitas terlebih 

dahulu oleh validator untuk divalidasi. Adapun validasi pada penelitian ini dil-

akukan kepada tim ahli validator, yaitu kepada 2 Dosen Fakultas Tarbiyah dan 

Keguruan UIN Antasari Banjarmasin dan 1 orang guru kimia di MAN 3 Banjar. 

Validasi dari tim validator kemudian dihitung persentasenya dengan rumus sebagai 

berikut: 

𝐻𝑎𝑠𝑖𝑙 =
𝑇𝑜𝑡𝑎𝑙 𝑆𝑘𝑜𝑟 𝑦𝑎𝑛𝑔 𝐷𝑖𝑝𝑒𝑟𝑜𝑙𝑒ℎ

𝑆𝑘𝑜𝑟 𝑀𝑎𝑘𝑠𝑖𝑚𝑢𝑚
 × 100% 

 



42 

 

 

 

Kriteria hasil validasi dapat dilihat pada Tabel 3.9 (Sa’adunَAkbar,َ2013). 

Tabel 3.9 Kriteria Hasil Validasi 

No Skor Kriteria Validitas 

1. 81 - 100 % Sangat Layak 

2. 61 - 80 % Layak 

3. 41 - 60 % Cukup Layak 

4. 21 - 40 % Tidak Layak 

5. < 21 % Sangat Tidak Layak 

 

Adapun hasil validasi instrumen soal oleh tim validator dapat dilihat pada 

Tabel 3.10. 

Tabel 3.10 Hasil Validasi Soal  

No Nama Validator Hasil Validasi % 

1. Alvian Ikhsanul Fatya, S.Pd., M.Si 91,79% 

2. Khairiatul Muna, S.Pd., M.Pd 80% 

3. Naimah, S.Pd 75,83% 

Persentase Rata-Rata 82,54% 

 

Persentase keseluhan dari hasil validasi instrumen soal oleh tim validator 

diperoleh hasil sebesar 82,54%. Adapun kriteria validitas yang tercantum pada 

Tabel 3.9 akan digunakan peneliti sebagai acuan kriteria validitas. Berdasarkan 

Tabel 3.10 dapat diketahui bahwa instrumen soal tersebut termasuk dalam kriteria 

sangat layak. Oleh karena itu instrumen ini dapat digunakan untuk penelitian. Perhi-

tungan validasi soal oleh validator dapat dilihat pada lampiran. 

b) Validasi Eksternal 

Uji coba validitas pada penelitian ini dilakukan kepada peserta didik kelas 

XII IPA di MAN 3 Banjar dengan jumlah peserta didik sebanyak 28 orang. Uji 

validitas dilakukan dengan menggunakan rumus pearson product moment dengan 

bantuan software SPSS versi 24. Pengambilan keputusan dapat dilakukan dengan 

membandingkan nilai r hitung dengan r Tabel pada taraf signifikansi 5%. Instrumen 
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dinyatakan valid, jika nilai r hitung > r Tabel, dan instrumen dinyatakan tidak valid 

jika nilai r hitung < r Tabel. Hasil uji coba tersebut kemudian diukur dengan 

menggunakan sofware SPSS versi 24 sebagai berikut. 

Menu Analyze –Correlate – Bivariate –Item– Correlation Coeffcients Pear-

son – Ok 

Hasil data dari perhitungan yang dilakukan terdapat 6 soal yang nilai r hi-

tung < r Tabel sehingga dikatakan tidak valid yaitu soal nomor 3, 6, 11, 13, 19, dan 

23. Sedangkan ada 19 soal yang nilai r hitung > r Tabel sehingga soal tersebut 

dikatakan valid dan dapat digunakan dalam penelitian. Hasil uji coba instrumen soal 

kognitif dipaparkan pada Tabel 3.11. 

Tabel 3.11 Hasil Uji Coba Instrumen Soal 

No Soal RTabel Signifikasi 5% Rhitung Keterangan 

1. 

0,374 

0,410 Valid 

2. 0,437 Valid 

3. 0,218 Tidak Valid 

4. 0,481 Valid 

5. 0,430 Valid 

6. 0,299 Tidak Valid 

7. 0,434 Valid 

8. 0,512 Valid 

9. 0,434 Valid 

10. 0,466 Valid 

11. 0,281 Tidak Valid 

12. 0,413 Valid 

13. 0,272 Tidak Valid 

14. 0,698 Valid 

15. 0,430 Valid 

16. 0,389 Valid 

17. 0,420 Valid 

18. 0,401 Valid 

19. 0,164 Tidak Valid 

20. 0,394 Valid 

21. 0,458 Valid 

22. 0,528 Valid 

23. 0,250 Tidak Valid 
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No Soal RTabel Signifikasi 5% Rhitung Keterangan 

24. 0,442 Valid 

24. 0,413 Valid 

 

2) Uji Reliabilitas  

Reliabilitas adalah sejauh mana pengukuran dari suatu tes tetap konsisten 

setelah dilakukan berulang-ulang terhadap subjek, dan kondisi yang sama. Uji reli-

abilitas dilakukan menggunakan pengujian statistik Cronbach's Alpha dengan ban-

tuan software SPSS versi 24 for windows. Adapun kriteria nilai uji reabilitas adalah 

sebagai berikut. 

 Cronbach's Alpha > 0,70, maka instrumen dikatakan reliabel 

 Cronbach's Alpha < 0,70, maka instrumen dikatakan tidak reliabel 

Adapun langkah-langkah dari uji reliabilitas sebagai berikut. 

Data →Analyze →Scale → reability analysis → items → statistics → items, 

scale, scale if item delete, dan inter-item correlations → continue→ Ok 

Hasil Uji Reliabilitas dapat dilihat pada Tabel 3.12. 

Tabel 3.12 Hasil Uji Reliabilitas  

Reliability Statistics 

Cronbach’s alpha N of Items 

0,802 19 

 

Berdasarkan hasil uji reliabilitas diperoleh nilai Cronbach’s Alpha yaitu 

0,802. Hasil uji reliabilitas instrumen soal post-test dapat disimpulkan bahwa 0,802 

> 0,70, maka soal dinyatakan reliabel.


